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Introduction to What's New 

This edition of the "What's New" describes many notable new features and enhancements in 

version 10.96.1 since the previous release (10.96). For information on features and 

enhancements made in earlier versions, see the appropriate "What's New" document for 

those versions. 

 

For information on fixes made in version 10.96.1, see the appropriate "Resolved Issues" 

document.  

 

Note that if updates need to be made, the most up to date "What's New" and "Resolved 

Issues" documents can be found in our online documentation here:  

 

Release Notes 

Structure of the Document 

This document is split into chapters for the different areas of the ICONICS Suite, then 

further into sections for major updates, representing significant enhancements or new 

functionality, followed by tables of additional enhancements and fixes. 

Where appropriate, references to additional information, such as instructional 

application notes or help files, will be indicated. 

https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Com/Intro/Release_Notes.htm
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Most Notable Features 

Some of the most notable new features in 10.96.1 are listed below. Visit each link to 

learn more and see the "Major Enhancements" sections for each product for additional 

notable features. 

• Installation 

o Configuration Files Merged on Upgrade, for a more seamless upgrade 

experience 

• AnalytiX 

o CFSWorX 

▪ New: Standalone Installation 

▪ Sort Workers Based on Travel Time, to notify the worker that can 

reach the event first 

▪ Vonage Alerts 

o FDDWorX & Facility AnalytiX 

▪ Faults Available as Alarms 

▪ Fault Viewer can display Asset Icons 

• Data Connectivity 

o SNMP Point Manager 

▪ Redesign, Performance Improvements 

• GENESIS64 

o AssetWorX 

▪ Cache now Reads Changes from Database, opening the possibility 

for redundant AssetWorX servers 

• IoTWorX & Internet of Things 

o IoT Analyzer Fault Incidents Available as Alarms 

o BACnet Connectivity in IoTWorX Edge Devices 

• KPIWorX 

o Pivot Functionality in Table and Categorical Chart 

• MobileHMI & HTML5 WebHMI 

o Specifying Language in URL, so multilanguage systems can have links that 

open directly in their language 

o Push Notification Support for iOS and Android apps
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General 

Installation 

Major Enhancements 

Configuration Files Merged on Upgrade 

(Reference ID: 76555) 

Previously, when installing one version of ICONICS Suite products on top of another, the 

various configuration files (other than the configuration databases) would be 

overwritten with the defaults in the new version. This could affect settings such as the 

FrameWorX Server Location or any customizations users made to the configuration files. 

Starting in version 10.96.1, the installation will back up the configuration files and 

update them with any settings added by the new version. This should provide a more 

seamless upgrade experience since user settings will be maintained instead of being 

reverted to a default. 

This feature only applies when upgrading from version 10.96 or later. ICONICS plans to 

maintain this feature in future upgrades, allowing users to upgrade more seamlessly 

from 10.96 or later to any future versions. 

For Further Reference 

• Help: Configuration Files Merged on Upgrade  

Additional Enhancements 

Ref ID Description 

76659 

The Asset AnalytiX configuration is now installed by the default in the starting configuration database in GENESIS64 

installations. This makes it easier for users installing from the GENESIS64 installation media to use the AssetWorX-

Hyper Historian integration. 

https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Com/Intro/Configuration_Files_Merged_on_Upgrade.htm
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AnalytiX 

AnalytiX-BI 

Major Enhancements 

Enhancements to PIVOT Queries 

(Reference IDs: 74145, 74701, 74710) 

A number of enhancements were made to the PIVOT keyword. 

PIVOT queries now allow to specify GROUP BY columns either explicitly or under the 

PIVOT clause. For example, the following two queries are equivalent: 

PIVOT 

    SUM(OrderDetails.Quantity), 

FOR  

    Categories.CategoryName IN ('Beverages', 'Condiments', 'Seafood') 

GROUP BY 

    Orders.[OrderDate.Year] AS Year 

ORDER BY 

    Orders.[OrderDate.Year] 

 

PIVOT 

    SUM(OrderDetails.Quantity), 

    Orders.[OrderDate.Year] AS Year 

FOR  

    Categories.CategoryName IN ('Beverages', 'Condiments', 'Seafood') 

WHERE  

    OrderDetails.UnitPrice > 20.0 

ORDER BY 

    Orders.[OrderDate.Year] 

 

Note, if GROUP BY columns are specified both in the PIVOT clause and the GROUP BY 

clause an error will be returned. 

A WHERE clause can optionally be applied before the GROUP BY or ORDER BY clause, 

like follows: 

PIVOT 

    SUM(OrderDetails.Quantity), 

    Orders.[OrderDate.Year] AS Year 

FOR  

    Categories.CategoryName IN ('Beverages', 'Condiments', 'Seafood') 

WHERE  

    OrderDetails.UnitPrice > 20.0 

ORDER BY 

    Orders.[OrderDate.Year] 
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Pivoted columns can now appear in the ORDER BY clause, as in this example: 

PIVOT  

    SUM(Products.UnitsInStock)  

FOR  

    Categories.CategoryName IN ('Beverages', 'Condiments')  

GROUP BY  

    Orders.[OrderDate.Year]  

ORDER BY  

    Categories.Beverages 

 

And PIVOT queries now allow post-filtering the pivoted dataset on pivoted columns 

using the HAVING statement, as in this example: 

PIVOT  

    SUM(Products.UnitsInStock),  

    Orders.[OrderDate.Year]  

FOR  

    Categories.CategoryName in ('Beverages', 'Seafood')  

HAVING  

    Categories.Seafood > 4000 

 

For Further Reference 

• Help: AnalytiX BI Server SQL Queries - Pivot  

New Quality Functions 

(Reference ID: 75478) 

Several new functions were added to AnalytiX-BI to be used in data flow and data table 

configurations. These functions help in identifying tag quality. 

• Isgoodq(quality) - Returns whether the quality code (uint) is good. 

• Isbadq(quality) - Returns whether the quality code (uint) is bad. 

• Isuncq(quality) - Returns whether the quality code (uint) is uncertain. 

• Getdescq(quality) - Returns the human readable description for the quality code 

(uint). 

These functions are custom to AnalytiX-BI only. 

For Further Reference 

• Help:   

o Quality-Based Functions in Expression in AnalytiX-BI Server 

o Data Flows 

o Data Tables  

https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/AnalytiX_BI_Server/AnalytiX-BI_Server_SQL_Queries.htm
https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/AnalytiX_BI_Server/Quality-based_Functions_in_Expressions_in_AnalytiX-BI_Server.htm
https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/AnalytiX_BI_Server/DataFlows.htm
https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/AnalytiX_BI_Server/Data_Tables.htm


AnalytiX - BridgeWorX64 & Workflow 

9 

Additional Enhancements 

AnalytiX-BI General 

Ref ID Description 

74283 

74516 

Data flows now support daylight savings changes when using the Data Sources > Historical Data > Hyper Historian 

Aggregated Data step. This is done by adding a new Time Zone setting. The time zone selected will be used to 

determine daylight savings information in order to correctly interpret the processing interval on transition days. By 

default, the BI server's local time zone is used. 

BridgeWorX64 & Workflow 

Common 

Ref ID Description 

60907 

Added new option to the CSV File Output activity: "Append new lines to existing CSV file. Do not overwrite if file 

already exists." When this option is unchecked, the activity will overwrite existing CSV files, as in previous versions. 

When checked, the activity will instead append new lines to the existing CSV file. 

 

Note, when appending, the existing headers in the CSV file will be ignored. If the existing file's headers do not match 

the schema of the dataset being written there may be unexpected results. Also note that there is no check for 

maximum file size. 

72960 
Duplicating a BridgeWorX64 or Workflow block now adds a number to the end of the name instead of giving the 

new block a generic name of "ActivityXXX". 

74371 

Historical input blocks now have the option of including bad quality or uncertain data samples. There is a new option 

in the block properties called, "Ignore Bad Quality Data Samples". Uncheck this property to include bad quality and 

uncertain samples in the results. 

 

Note, this option is only available for English locales. Non-English locales will assume the "Ignore Bad Quality Data 

Samples" option is enabled, which is consistent with the behavior of previous versions. 

BridgeWorX64 

Ref ID Description 

71682 

Added these tags to monitor the health and status of the BridgeWorX64 point managers: 

 

BridgeWorX Point Manager (browsable under Bridging): 

bwx:@@Active 

bwx:@@Online 

bwx:@@RequestedTransactionCount 

bwx:@@RejectedTransactionCount 

bwx:@@SuccessfulTransactionCount 

bwx:@@FailedTransactionCount 

bwx:@@CancelledTransactionCount 

bwx:@@RunningTransactionCount 

bwx:@@DehydratedTransactionCount 

 

BridgeWorX64 Scheduling Service (browsable under Platform Services > BridgeWorX64 Scheduler): 

bwxs:@@Active 

bwxs:@@Online 

bwxs:@@State 

bwxs:QueueLength 

72220 

Previously, on a redundant system when a transaction was configured for distributed recovery, if the transaction was 

hibernating while that node failed, the transaction would have been sent to another node to be recovered, while at 

the same time if the original node recovered the transaction would awaken and finish on that node as well, leading to 

duplicate execution. 
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Ref ID Description 

Now, the interaction of distributed recovery and hibernation has been enhanced so that when a node with 

hibernating transactions fails, if the transactions are sent to another node to be recovered the original transactions 

will be canceled. 

74909 

74907 

The Generic JSON Writer and CSV File Output activities now provide output datasets. The output dataset consists of 

one row and four columns for FolderName, FileName, JsonContent or CsvContent, and Status. 

BridgeWorX64 Navigator 

Ref ID Description 

75015 

To use the value of a global alias as a root node, users can now enter just the <#alias#> syntax in the Root Node 

Path properly. Previously, expression syntax like this was required: {{"<#alias#>"}}. The previous expression syntax is 

still supported. 

BridgeWorX64 Viewer 

Ref ID Description 

72929 The BridgeWorX64 Viewer's filter now has an option to show transactions in all states. 

BridgeWorX64 & Workflow Workbench Providers 

Ref ID Description 

74408 The delay activity now includes a sampling rate field to determine how often the delay expression is evaluated. 

Workflow 

Ref ID Description 

74994 

Global alias resolutions are now cached. This improves the speed of blocks that utilize global aliases, especially when 

the same alias is used in many tags. The first time an alias is used it may take 10-40 milliseconds to resolve, but 

further uses of the alias should be instantaneous. 

 

CFSWorX 

Major Enhancements 

General 

New: Standalone Installation 

(Reference ID: 76308) 

CFSWorX is now available as a standalone installation separate from ICONICS Suite and 

other packages. To minimize download time and installation footprint, this installation 

provides only the core components necessary to configure a CFSWorX application. 

The CFSWorX standalone installation also provides a free trial that will work until 

December 31st, 2020. The free trial cannot be installed on the same machine as an 

existing licensed system; however, it can be installed on a separate physical or virtual 

machine and be configured to talk to a preexisting ICONICS system. 
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The CFSWorX standalone installation and free trial includes access to these features: 

• CFSWorX intelligent alarm or fault notifications to field workers. 

• AlarmWorX64 alarm server and alarm logger. 

• FDDWorX fault detection and diagnostics. 

• MobileHMI and WebHMI access for CFSWorX mobile screens and dispatcher 

desktop dashboard. 

• Remote expert functionality, allowing field workers video communication with an 

expert in the office. 

• GraphWorX64 design capabilities for editing prebuilt dashboard and remote 

worker mobile screen. 

• OPC UA, BACnet, and OPC Classic connectivity. 

Users who have installed the CFSWorX standalone installation can upgrade to a full 

ICONICS Suite system at any time by running the ICONICS Suite installation on top of 

the CFSWorX standalone installation. Your CFSWorX configuration will be preserved. 

Note, this will end the free trial period. 

To request your free trial of CFSWorX, visit https://iconics.com/cfsworx-free. 

Worker Access 

Sort Workers Based on Travel Time 

(Reference IDs: 66123, 74447) 

By default, CFSWorX's worker lookup activity sorts workers by distance. As a new option 

in 10.96.1, the worker lookup activity can sort workers based on travel time, rather than 

physical distance. The travel time is calculated using the driving time in Bing Maps. It 

can optionally take traffic data into account. 

To enable travel time sorting: 

1) Follow these instructions to get a Bing Maps key: 

https://github.com/Microsoft/BingMapsRESTToolkit/blob/master/Docs/Getting%

20Started.md#CreatingABingMapsKey  

2) Log into Windows as the user configured as the identity of the ICONICS 

Connected Field Worker services. This is very important, as we will be adding a 

user environment variable, and if it is added under the wrong user then travel 

time sorting will not function. 

3) Open Windows Settings. 

4) Search for Environment Variables. 

5) Select Edit environment Variables for your account. 

https://iconics.com/cfsworx-free
https://github.com/Microsoft/BingMapsRESTToolkit/blob/master/Docs/Getting%20Started.md#CreatingABingMapsKey
https://github.com/Microsoft/BingMapsRESTToolkit/blob/master/Docs/Getting%20Started.md#CreatingABingMapsKey
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6) Add a new user variable. 

7) For Variable name, enter Ico_Cfs_BingMapsKey. 

8) For Variable value, enter the Bing Maps key you obtained earlier. 

9) Select OK twice. 

10) If desired, you may log into Windows as a different user at this time. 

11) Restart the ICONICS Connected Field Worker Point Manager service if it was 

running. When it restarts, worker lookup activities will automatically sort based 

on travel time. 

a. Note, if the Worker Access Point Manager is not configured to run out-of-

process, restart the ICONICS FrameWorX service instead. This is not a 

common configuration.  

12) Open Workbench and create or edit your Connected Field Worker template. 

13) Select your worker lookup activity. 

14) In the Worker Lookup section, check Apply Location Restrictions and ensure 

the Location Data expression is properly filled with location data. 

15) Set Distance Measurement Type to Time. 

16) If desired, check Apply Traffic Calculation. This will apply traffic data to the 

travel time calculations. 

17) Apply the changes. 

To discontinue using Bing Maps travel time, delete the Ico_Cfs_BingMapsKey 

environment variable and restart the ICONICS Connected Field Worker Point 

Manager service, or simply change the Distance Measurement Type to Distance or 

Radius in the worker lookup activity. 

For Further Reference 

• Help:   

o Sort Workers Based on Travel Time 

o Worker Lookup 

Enhanced Group Filtering in Dynamics 365 Sources 

(Reference IDs: 66864, 68533, 72924) 

Dynamics 365 sources under Connected Field Worker > Field Workers includes a new 

section called Only users from specific group(s). When enabled, this section 

determines which groups and users are imported into CFSWorX. (When disabled, all 

users and all groups of all group types will be imported.) 

Filtering on resources category, organizational unit, and characteristic group types were 

already allowed. These fields were moved to the Only users from specific group(s) 

section. Filtering is now also allowed on business unit, team, and territory group types. 

https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/Connected_Field_Worker/Sort_Workers_Based_on_Travel_Time.htm
https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/Connected_Field_Worker/Templates.htm%23Worker_Lookup
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All group filters are now browsable. Before browsing is allowed, the Dynamics 365 

connection information must first be configured and applied. Once the connection has 

been made, go to the Only users from specific group(s) section, select the Enabled 

box, find the group type you are interested in, change the dropdown from All to 

Specific, then use the more (…) button to select the specific groups. Remember to hit 

apply when you are finished configuring all filters. 

For Further Reference 

• Help: 

o Enhanced Group Filtering in Dynamics 365 Sources 

o Field Workers 

Enhanced Group Filtering in Worker Lookup 

(Reference IDs: 72534, 72536) 

In worker lookup activities, the Group Name field has been replaced by Group Data. The 

Group Data field allows more than one group name, separated by commas, and 

supports expressions. Workers will be returned if they are in one or more of the listed 

groups. 

It also allows the user to specify proficiency levels by putting the level in parentheses. 

For example, specifying Software support (Proficient),Software Support (Good) will 

find users who are either good or sufficient at software support. 

This new syntax can also be used in the GroupName parameter of wa: tags.  

For Further Reference 

• Help:   

o Worker Lookup 

o Field Workers 

Workflows and Alerts 

Vonage Alerts 

CFSWorX can now send alerts using Vonage. See the AlertWorX feature: Vonage Alerts. 

Workflows can now Subscribe to FDDWorX Fault Incidents 

(Reference ID: 72325) 

In its initial release, CFSWorX was only able to alert workers based on AlarmWorX64 

Server alarms. Now in addition to alarms, CFSWorX can alert based on FDDWorX Fault 

Incidents. 

https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/Connected_Field_Worker/Enhanced_Group_Filtering_in_Dynamics_365_Sources.htm
https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/Connected_Field_Worker/Field_Workers.htm
https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/Connected_Field_Worker/Templates.htm%23Worker_Lookup
https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/Connected_Field_Worker/Field_Workers.htm
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To subscribe a workflow to fault incidents: 

1) Open Workbench. 

2) Edit Connected Field Worker > Workflows > your configuration. 

3) Go to the Alarm Settings tab. 

4) Add a new subscription. 

5) Select the browse button in the new row. 

6) Browse to My Computer > AnalytiX > FDDWorX. 

7) Select FDDWorX to subscribe to the entire set of fault incidents or a specific asset 

underneath for faults related to that asset. 

8) Select OK. 

9) Select Apply. 

For Further Reference 

• Help: Workflows 

Acknowledge Alarms Via WhatsApp 

(Reference ID: 66866) 

Users can now respond to a Twilio WhatsApp alert message from CFSWorX to 

acknowledge the alarm. 

Similar to acknowledging messages via SMS sent by Twilio, to acknowledge an alarm 

the recipient can respond to the WhatsApp alerts with the message ID, their 

acknowledge code, and an optional comment. 

Acknowledging via WhatsApp requires a WhatsApp business account. Currently only 

WhatsApp messages sent from Twilio support this feature. See the reference links below 

for information on how to configure acknowledgements. 

For Further Reference 

• Help: Notification Methods 

Additional Enhancements 

Ref ID Description 

68933 
Added a "Synchronize Now" button to Active Directory and Microsoft Dynamics 365 worker sources. This button will 

trigger an immediate synchronization. 

70465 
To aid in troubleshooting, recipient information is now logged in TraceWorX and GenEvent messages when 

notifications are sent from a CFSWorX workflow. 

70583 

Information about the current worker from a worker lookup or fixed contact list activity is now available to be used in 

expressions. These new variables are available in the expression editor of CFSWorX workflow templates: 

 

* cfscoreVariable:WorkerName 

* cfscoreVariable:WorkerEmail 

* cfscoreVariable:WorkerPhone 

https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/Connected_Field_Worker/Workflows.htm
https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/Connected_Field_Worker/Notification_Methods.htm
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Ref ID Description 

* cfscoreVariable:WorkerSMS 

* cfscoreVariable:WorkerVOIP 

* cfscoreVariable:WorkerWhatsApp 

* cfscoreVariable:WorkerServiceContact (Twilio or Vonage number) 

 

These variables are only valid after a worker lookup or fixed contact list activity is called by the workflow. 

 

For worker lookup activities, this information is gathered from the worker database. For fixed contact lists, 

cfscoreVariable:WorkerName will get its value from the Field Worker column and all other variables listed above will 

get their value from the Contact column. 

71146 

The optional event posted when an alert block is processed now includes information about the user being 

contacted. (This event can be enabled or disabled using the "Post event when block processed" box on the alert 

activity.) 

73110 

73109 

When importing workers from Microsoft Dynamics 365, if the workers have an Azure Active Directory ID this ID will 

be imported.  

 

When planning to synchronize ICONICS security with Azure Active Directory, it is recommended to configure the 

security synchronization before importing workers from Dynamics. This order will allow CFSWorX to display the 

proper security name filled in for each worker immediately after import. Configuring the system in the reverse order 

(Dynamics worker import first, then security connected to Azure Active Directory) is allowed, and the workers will still 

be connected to security, but the security names will not be immediately visible. 

74137 The performance of wa: tags was greatly improved when using a dataset with around 500 or more workers. 

74207 

Improved the efficiency of deleting an Active Directory or Microsoft Dynamics 365 source. Deleting these sources will 

no longer use as many system and point manager resources and will no longer log as many messages into 

TraceWorX. 

74443 

The DynamicsCreateWorkOrder method (usable with the “call method” global command) now returns the work order 

ID (GUID) when it successfully creates a work order. Note, batch commanding must be used in order to access a 

return value from a command. 

 

The ID is also included in the GenEvent message that gets logged when the method successfully creates a work 

order. 

75465 The default timeout for new worker lookup blocks has been changed to 10 seconds. 

75620 

Added a new variable for use in CFSWorX workflow template expressions: cfscoreVariable:AreaAsString. This variable 

returns the area of the current alarm as a comma-separated string. AreaAsString is only available after a CFSWorX 

condition block (such as Alarm, Ack, Busy, Reject, etc.). 

75921 

The worker access wa: tags now contain a UserName parameter. Users who do not match the UserName are 

excluded from the results. This parameter can be used to get the data for a specific worker. If there are no workers 

matching the name, an empty result will be returned. 

76913 A shortcut to the CFSWorX dashboard has been added to the start menu in the ICONICS Tools folder. 

Facility AnalytiX & FDDWorX 

Major Enhancements 

FDDWorX Point Manager 

Faults Available as Alarms 

(Reference ID: 76064) 

FDDWorX faults are now exposed as OPC UA alarms. 
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To subscribe to all faults, browse under AnalytiX and choose FDDWorX. To subscribe 

to the faults for a particular asset, choose that asset under FDDWorX. The subscription 

tag name should start with fdd:. 

For Further Reference 

• Help: Fault Detection and Diagnostics 

Fault Viewer Control 

Asset Icons 

(Reference ID: 72714) 

The fault viewer control can now display asset icons. To add a column for icons: 

1) In your fault viewer, go to the Fields page. 

2) Add a new field. 

3) For Data Column, select Asset Icon. 

4) Go to the Columns page. 

5) Select the Add new item to the collection  button and choose the AssetIcon 

field or select the Generate columns from list of fields  button to have the 

field added automatically. 

6) Reorder the columns as desired. 

The fault viewer control can also support interpreting any string field as an icon. The 

source for these icons is the AssetWorX icon repository, configured in Workbench 

under Assets > Product configuration > Images. The expected format of the string is: 

ac:.Icon Definitions/name (example: ac:.Icon Definitions/Enterprise). Note that 

expressions can be used to build the string name if the database or asset provides only 

part of the required string (example expression: x="ac:.Icon Definitions/" + 

{{@@value}}). 

To change a string column into an icon, go to the Columns page, select the column in 

question, and set the Content Type to Icon. 

The table control also supports interpreting string fields as icons. See Display Icons from 

AssetWorX Configuration. 

For Further Reference 

• Help:  

o Asset Icons in Fault Viewer Control 

o Fault Viewer 

o Images Node 

https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/FDDWorX/Fault_Detection_and_Diagnostics.htm
https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/GWX/Asset_Icons_in_Fault_Viewer_Control.htm
https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/GWX/Fault_History.htm
https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/AssetWorX/Images_Node.htm
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Predefined Comments 

(Reference ID: 52011) 

Users can now configure a predefined list of comments the user can choose from when 

commenting on a fault. 

To configure the predefined comments, go to the new Comments page in the fault 

viewer configuration. Check the Configurable Comments box, then use the Add button 

to add a new comment. Each configured comment must have a Display Name, which is 

the text that will be displayed when the user is choosing, and a Comment, which is the 

actual text that will be used in the comment. Both the Display Name and Comment 

fields support aliases and expressions. 

In runtime, when this option is enabled the Add Comment dialog includes a new 

dropdown box called Select Comment. The user can optionally choose a predefined 

comment from this list, and it replace the text in the Comment field. The user can then 

further modify the comment before submitting, if needed. 

For Further Reference 

• Help:  Fault Viewer 

Additional Enhancements 

General 

Ref ID Description 

70188 

Faults configured with a constantly false expression (such as "x=0" or "x=False") in the Enabled field are no longer 

loaded, meaning their data sources are not subscribed. Faults with a dynamic expression in the Enabled field are still 

loaded, even if the expression evaluates to zero. 

72711 
GenEvents are now generated when faults are acknowledged. The event includes the incident ID, name of the user 

who acknowledged the fault, and the acknowledgment comment (if any). 

Fault Viewer 

Ref ID Description 

58312 

Added a new property called Maximum String Size. It can be found on the General page in the Data section. This 

property, which defaults to 1000, limits the number of characters displayed for string values. This improves the 

performance when data sources contained extremely long strings. 

69682 

Previously, when configuring the fault viewer, if a user wanted to choose a literal asset as the parent (as opposed to a 

localsim value or tag that would resolve to an alias name), they had to use the tag browser button, choose the asset, 

then remove the double curly brackets.  

 

Now, there is a new button attached to the Parent field specifically for browsing assets. Users can use this button to 

choose their literal asset, and their choice will not be wrapped in double curly brackets. 

72289 Improved the loading time of fault incidents when using a distributed architecture. 

72460 

71294 

The scrollbar performance has been improved when using incremental loading to better reflect the size of the full 

data source on the server and respond more intuitively when more rows are loaded from the server. 

 

https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/GWX/Fault_History.htm
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Ref ID Description 

When incremental loading is disabled, the contents of old pages are no longer discarded. This means when a user 

moves from page one to page two then back to page one, page one's data will load immediately without having to 

retrieve the rows from the server again. 

 

Scrollbar performance in general has been improved. 

72712 

Added two new properties in the Controls page, Dialogs section. These both affect the pop-up dialog that is 

displayed when the user adds comments, acknowledges, resolves, or deactivates faults. 

 

* Show Current User: When enabled, this displays the currently logged-in user (if any) at the top of the pop-up 

dialog. This is enabled by default. 

 

* Allow Custom User: When enabled, if no user is currently logged into ICONICS security the user is allowed to supply 

a custom username in the pop-up dialog. This custom username is remembered and automatically filled in the next 

time the dialog is reopened. Note, this cannot be used to override the logged-in ICONICS security user. 

72747 The scroll position is now maintained after the data source is refreshed. 

72838 
Added "Margin" as a new property of columns. Margin determines the minimum space allowed between the cell 

content and the cell border. 

72868 

There are two new preconfigured views for the fault viewer: Active Fault Statistics and Active Fault Incidents. These 

work like the preexisting Fault Statistics and Fault Incidents views; except they only display information about active 

faults. These are selectable from the Views menu of the Fault Viewer ribbon in configuration mode. 

75131 
When adding a filter, the tag browser now displays the Simulation tab, allowing users to choose localsim values for 

the filter's value field. Prior to this fix, localsim values worked but the user had to type them in manually. 

75496 

Added a "Row Click" event to the table and fault viewer controls. This new event is different from the preexisting 

"Row Selected" event because "Row Selected" only occurs when the row is first selected. The row must first be 

deselected before the "Row Selected" event will be triggered again for that row. The new "Row Click" event will be 

executed any time the row is clicked or touched, even if it is already selected. 

ReportWorX64 & ReportWorX64 Express 

Major Enhancements 

Select Multiple Values for Parameters 

(Reference ID: 74303) 

ReportWorX64 now allows users to select multiple values for list parameters. To use this 

new feature: 

1) Edit the ReportWorX64 template in Excel. 

2) Open the Parameters window. 

3) Select a parameter of type Select from a fixed list of values or Select from a 

dynamic list of values. 

4) Enable Allow Multiselection. 

5) If desired, enable Limit Selection to and choose a limit value. 

6) Select Save and close. 

7) Open Workbench. 

8) Select the template object. 

9) Upload your Excel file as a new version of the template. 

10) Select the report object that uses your template. 
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11) In the Advanced Properties section, choose an option for Multi-value 

Parameters depending on whether you want one sheet per parameter value, or 

all parameter values merged into one sheet. 

12) Apply the changes, if needed. 

13) Use the ReportWorX64 Viewer or the ReportWorX64 button in the GraphWorX64 

runtime menu to execute your report. Select multiple values for your multi-select 

parameters. 

For Further Reference 

• Help: Multiple Value Selection for Parameters 

Additional Enhancements 

ReportWorX64 Excel Add-In 

Ref ID Description 

72196 Mapping multiple instances of the same column in a dataset is now allowed. 

72239 Text orientation is now preserved for data sources wrapped in an Excel table. 

72330 Added support for or disabled various Excel features that previously could break ReportWorX64 mappings. 

72400 Transposing a data source now keeps style changes. 

72626 Improved the experience of copying and pasting when the add-in was enabled. 

73042 Various small user interface changes to improve ease of use. 

73245 

The "Turn Cell into Parameter" feature now attempts to infer the parameter data type from the cell formatting. For 

example, if the cell is formatted as a date then the parameter will be created with a type of "date time". When the 

data type cannot be inferred, a data type of string will be used. 

74144 

When downloading data, the "Select Parameter(s) Values" dialog now lists parameters after their dependent 

parameter, if any. For example, if ParamA depends on the value chosen for ParamB, ParamB will be listed first in the 

dialog. 

74286 

Previously, if a real-time data source value responded with a bad quality sample, that sample would be used in the 

report, even if the status was temporary and a good value followed shortly. Now, upon receiving a bad quality 

sample the report will wait a configured period of time to see if a good quality sample will follow. This wait time can 

be configured on a per-data source basis using the new "Bad Quality Delay" setting. 

75782 
Previously when the template is in data mode (showing downloaded data), changes were extremely limited. Now, 

certain changes are allowed, and will persist after the data is cleared. 

ReportWorX64 Navigator 

Ref ID Description 

75015 

To use the value of a global alias as a root node, users can now enter just the <#alias#> syntax in the Root Node 

Path properly. Previously, expression syntax like this was required: {{"<#alias#>"}}. The previous expression syntax is 

still supported. 

ReportWorX64 Workbench Provider 

Ref ID Description 

72967 

75829 
"Send Email" redirector commands now support From, CC, and BCC fields. 

 

 

https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/Reports/Multiple_Value_Selection_for_Parameters.htm


Data Connectivity - BACnet Point Manager 

20 

Data Connectivity 

BACnet Point Manager 

Workbench Provider 

Ref ID Description 

69144 
The Read Range Type can now be configured on a per-device basis. In the device configuration, check "Override 

Read Range Type", then choose the desired type. 

72612 

Added a new option on the BACnet > Devices object > General tab called, "Read Description From Devices". If 

enabled, when browsing a node, Workbench will subscribe to any descriptions of that node's children. When 

disabled, Workbench will not load the child descriptions. This feature is disabled by default to reduce network traffic 

and load on the devices. 

 

This option replaces the ReadDescriptions INI entry that was added in version 10.96 (reference ID: 60752). 

GridWorX 

GridWorX Server 

Ref ID Description 

71120 

73137 

The GridWorX Point Manager now supports the query protocol. 

 

Currently the query protocol is only used by the table control when choosing "query" as the type. Previously, 

GridWorX data sources would only be usable using a type of "dataset" in the table control. 

 

The query protocol is more efficient when modifying the original dataset, such as by sorting, calculating aggregates, 

or displaying only a subset of the columns. The query protocol allows the server to more efficiently process those 

modifications before sending the data to the client, whereas with the original dataset protocol the client had to 

retrieve the entire dataset and modify it on the fly in runtime. 

GridWorX Viewer 

Ref ID Description 

72951 

Added a new advanced property to a series. This property is called "Hide zero or null samples". When enabled, 

samples that are zero or null will not be plotted. This can be used to hide slices of a pie chart where the value is zero, 

though it applies to all chart types. 

 

This property is currently only supported in the desktop (WPF) platform. Support for HTML5 and Universal Windows 

Platform (UWP) is planned for future versions. 

SNMP Point Manager 

Major Enhancements 

Redesign, Performance Improvements 

(Reference ID: 72898) 

The SNMP point manager has been redesigned from the ground up to gain major 

improvements in performance and give users more control over their SNMP networks. 
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In particular, there were several improvements designed to increase performance on 

networks that have many devices and networks that may have a lot of devices go offline 

at one time. Offline devices should no longer affect the performance of online devices. 

The mapping of SNMP traps to OPC alarms and events has been improved, as has the 

performance of traps.  

There are new timeout settings for exploring networks and devices. The timeout for 

device discovery is configured per network. Edit a network and set the Read Timeout in 

the SNMP Settings section. There is also a timeout setting in the discovery dialog itself 

that governs the timeout of the whole discovery process. This is configured in the 

SNMP Explorer. Expand Explorer Advanced Settings and set a value for Cancel 

device discovery after … minutes. 

There are new settings configurable under Data Connectivity > SNMP > Networks 

that can modify communication behavior. These settings include: 

• Max unused socket time: How long the point manager caches sockets that are 

not used. A setting of zero indicates they are cached until the next restart. 

• Max active requests: The limit of the total number of the requests across all 

devices that can be executed at the same time. A setting of zero indicates no 

limit. 

• Max active requests per device: Limit of requests per device that can be 

executed at the same time. A setting of zero indicates no limit. 

• Device status errors: If a device receives this number of consecutive errors (or 

more), it will switch to offline mode. 

• Device status polling rate: The polling rate for the device status. Active devices 

are polled continuously at this rate, but offline devices will be polled at an 

increasingly slower rate. Each offline result slows the rate of the next check by ten 

seconds, up to a maximum of five minutes. 

For Further Reference 

• Help:  

o Traps 

o Networks 

o Explore Network 

 

https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/SNMP/Traps.htm
https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/SNMP/Networks.htm
https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/SNMP/Explore_Network.htm
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Additional Counters 

(Reference ID: 52930) 

More counters have been added to monitor the performance of the SNMP point 

manager. These counters can be accessed in the data browser under Data Connectivity 

> SNMP > .counters or Data Connectivity > SNMP > network > device > .counters. 

Root counters: 

• Device Subscribed Offline Count – The number of the devices that are on scan 

but offline 

• Device Subscribed Online Count – The number of the devices that are on scan 

and online. 

• Request Average Process Time – The average time that is needed to process 

one request (read or write), calculated since the point manager was started. 

• Request Average Queue Time – The average time that the request waits in the 

processing queue, calculated since the point manager was started. (This is part of 

the average process time.) 

• Request Processed Count Total – The total number of the processed requests 

since the point manager was started. 

• Server Running – Elapsed time from the moment when the point manager was 

started. 

• Server Started – The timestamp of when the server was started, UTC time. 

• Socket Allocated Count – The number of allocated sockets that are used for the 

communication with devices over the network. 

• Socket Blocked Count – The number of the sockets that are currently in use. 

• Socket Blocked Count Total – The total number of the sockets that have been 

created since the point manager was started. 

• Socket Freed Count – The number of the sockets that are currently available. 

• Socket Freed Count Total – The total number of the sockets that have been 

freed since the point manager was started. 

• Tag Client DA Subscription Count – The number of active client DA 

subscriptions. 

• Trap Aborted Count Total – The total number of aborted traps. 

 

Device counters: 

• Request Average Process Time – The average time that is needed to process 

one request (read or write), calculated since the point manager was started. 
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• Request Average Queue Time – The average time that the request waits in the 

processing queue, calculated since the point manager was started. (This is part of 

the average process time.) 

• Request Processed Count Total – The total number of processed requests. 

• Request Read Count – The number of currently running read requests. 

• Request Read Count Total – The total number of read requests processed since 

the point manager was started. 

• Request Read Error Count Total – The total number of read errors encountered 

since the point manager was started. 

• Request Write Count – The number of currently running write requests. 

• Request Write Count Total – The total number of write requests since the point 

manager was started. 

• Request Write Error Count Total – The total number of write errors 

encountered since the point manager was started. 

• Tag Subscribed Count – The number of currently subscribed tags, including DA 

and dataset tags. 

 

For Further Reference 

• Help: SNMP Counters 

Additional Enhancements 

SNMP Server 

Ref ID Description 

72349 

When exploring a network or device using SNMP v3, the SNMP point manager now logs an error to TraceWorX if the 

username or password was entered incorrectly. (In future versions we plan to make this feedback more immediately 

accessible.) 

SNMP Workbench Provider 

Ref ID Description 

72997 
If an error is encountered during network or device discovery, the device becomes red and the error is available in 

the tooltip. This can aid in troubleshooting device connectivity issues. 

 

https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/SNMP/SNMP_Counters.htm
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GENESIS64 

AlarmWorX64 

AlarmWorX64 Logger 

Ref ID Description 

50690 

Added a new IcoSetup64.ini entry that affects how the alarm logger retrieves historical alarm data when there are 

redundant logging databases: 

 

[AWX\AWXLog] 

UseAutoFailBack=0 

 

When UseAutoFailBack is set to 0 (disabled), if the primary database is offline the alarm logger will begin retrieving 

historical data from the secondary database and will not "fail back" to the primary automatically. It will continue 

getting data from the secondary database until the secondary fails or the logger is restarted. 

 

When UseAutoFailBack is set to 1 (enabled, default behavior), every time the alarm logger needs to retrieve historical 

data it will first try the primary database, then it will try the secondary database once the connection to the primary 

has timed out. After the primary has failed the connection will "fail back" once the primary has recovered. 

 

Users whose historical alarm viewers are configured to automatically refresh may wish to disable UseAutoFailBack to 

avoid situations where the auto-refresh of the viewer takes a long time while the primary database is offline (because 

the alarm logger is attempting to query the offline primary database with every refresh). 

AlarmWorX64 Server 

Ref ID Description 

36987 

Users can now prevent the alarm server from generating automatic text for the various Message Text fields of an 

alarm when no text is configured. To disable the automatic text generation, edit the IcoSetup64.ini file and add or 

modify this entry, then restart the alarm server if it was already running: 

 

[AWX\AWXServer] 

DisableAutoGenerateMessage=1 

75565 
Added a new Input_Tag_Quality point to the alarm DA server. This point reports the quality of the input tags.  

Example syntax: @ICONICS.AlarmSvr_.1\AlarmName.Input_Tag_Quality.Value 

76908 
Added Area_TagInput_Quality and Recursive_Area_TagInput_Quality to track the qualities of input tags for alarms in a 

given area. These tags report the lowest quality of all input tags in the area. 

AlarmWorX64 Viewer 

Ref ID Description 

52863 

When displaying historical alarms, the AlarmWorX64 Viewer now accepts the Navigate command with the "Navigate" 

property set to "More". This retrieves more records from the server, the same as the "More Data" option in the 

context menu or toolbar. 

77657 

When the "Force Comment" property is enabled for an AlarmWorX64 Viewer, comments consisting of just spaces are 

no longer allowed. 

 

Note, the "Force Comment" property is currently not enforced in Universal Windows Platform (UWP). We plan to add 

this support into UPW in a later version. 
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AlarmWorX64 Multimedia 

Ref ID Description 

75413 

On secure systems, sometimes the SNMP email agent could have problems sending emails due to being unable to 

access the stored SNMP credentials, or the agent will send fine, but the Test button could fail for similar reasons. The 

location of the encrypted SNMP credentials has been moved to help mitigate these issues. 

75914 Language aliases are now supported in AlarmWorX64 MMX templates. 

AlertWorX 

Major Enhancements 

Vonage Alerts 

(Reference IDs: 75409, 75084) 

Users can now send alerts using Vonage. Similar to Twilio, these alerts require a Vonage 

account. 

Vonage credentials can be configured under Alarms and Notifications > AlertWorX > 

Vonage Configurations. 

CFSWorX workflow templates can now include these alert blocks: 

• Send Vonage Message 

• Send Vonage Voice Message 

• Send Vonage WhatsApp 

For Further Reference 

• Application Note: CFSWorX - SMS Configuration 

• Help: Vonage Configurations 

Additional Enhancements 

Ref ID Description 

70644 
The AlertWorX message log now supports archiving old messages. To configure, go to Alarms and Notifications > 

AlertWorX > General Settings. 

AlertWorX Workbench Provider 

Ref ID Description 

72170 

Added test buttons to test SMS, WhatsApp, and voice connectivity. In the Twilio configuration item (under Alarms 

and Notifications > AlertWorX > Twilio Configurations > your item), go to the General Settings tab, scroll to the "Test 

this configuration" section, fill in the number and press the appropriate Test button. (The new Vonage configurations 

also support these test buttons.) 

75192 
Added additional logging for failed attempts to send a message. (The location of this log is configured under Alarms 

and Notifications > AlertWorX > General Settings > Logging Settings tab.) 

https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/AlertWorX/Vonage_Configurations.htm
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AssetWorX 

Major Enhancements 

Point Manager 

Cache now Reads Changes from Database 

(Reference ID: 72917) 

AssetWorX already included the ability to cache values written to equipment properties 

into a database so they could be preserved after the engine was restarted. This was 

configured with the Use database cache option on the Real Time Data tab of the 

equipment property. 

Previously, AssetWorX only read from this cache when starting. New in version 10.96.1, 

AssetWorX will monitor the database table for changes and propagate those changes to 

runtime. This provides new options, including the ability to have two AssetWorX 

installations run redundantly and share equipment property values via the cache 

database. 

For more information on how to access the cache data store and run redundant 

AssetWorX, see the further reference links below. 

For Further Reference 

• Help: AssetWorX Cache 

Additional Enhancements 

Ref ID Description 

63000 

Fields that accept <<@@>> aliases can now resolve the real-time value of equipment properties that have been 

cached (the "Use Database Cache" option is enabled and the value has been successfully cached). Previously this 

functionality was available only to static real-time values. The real-time value of equipment properties can be 

accessed using an alias such as: <<@@self/EquipmentPropertyName>>. 

70163 Assets are no longer shown as expandable in tree views if they have no children. 

72169 
Previously, for equipment properties on the Real Time Data tab, static string properties limited the value field to 1024 

characters. This limit has been removed. 

74615 
Attributes of equipment (such as .ChildEquipmentNames and .Description) now function for equipment in virtual 

trees. Note that .Path is an exception and does not function for equipment in virtual trees. 

77400 

The “External link type” and “External Link” fields for equipment have been renamed to “Link type” and “Link target”, 

respectively. The link target can now contain a link to the local AssetWorX. Previously, the only way to create a link to 

the local AssetWorX was to use points that included the name or IP address of the local machine. Using these links 

was very inefficient, and users are highly encouraged to use the new local link functionality instead of using the local 

name or IP address. 

 

Note, creating an excessive amount of external links (including links to the local computer using the local node name) 

is very memory intensive on both AssetWorX and the FrameWorX Server. Users are encouraged to minimize the 

external links, ideally to one link per remote server. 

 

https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/AssetWorX/AssetWorX_Cache.htm
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Ref ID Description 

Additionally, a warning is now logged to the FrameWorX Server’s TraceWorX log if a client creates too many AE 

subscriptions. 

AssetWorX Navigator 

Ref ID Description 

75015 

To use the value of a global alias as a root node, users can now enter just the <#alias#> syntax in the Root Node 

Path properly. Previously, expression syntax like this was required: {{"<#alias#>"}}. The previous expression syntax is 

still supported. 

75016 
If the Root Node Path property contains an alias and the value of that alias is changed, the navigator will 

automatically refresh. 

Controls 

Major Enhancements 

Common 

New Reference Property 

(Reference ID: 60394) 

In the past, for controls like the table, it could be difficult to configure the control when 

the control's data source tag name included a global alias or was generated by an 

expression. These aliases and expressions could not be resolved in configure mode, so 

information required to configure the control, such as the fields of the table control, had 

to be entered manually or possibly could not even be entered at all. 

Now, there is a new field available for many controls called Reference. The reference 

field appears under the data source field. When the data source has a dynamic name, 

the tag listed in the reference field will be used to configure the control. 

For example, in the table control, if the data source was set to a dynamic tag name, alias 

like "db:Northwind.<#TableName#>", the control cannot determine the value of the 

<#TableName#> alias in runtime, so the "generate fields" button on the Fields tab 

would not be able to retrieve any fields. However, when the reference field is set to a 

static tag name, like "db:Northwind.Reviews", the "generate fields" button will be able to 

successfully retrieve the fields from the Reviews data source. 

For best results, users should ensure that the tag name used in the reference field is a 

valid possible result of the aliases or expression used in the data source field. 

The controls that have this new reference field are: 

• Table 

• Heatmap 
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• Data Diagram  

For Further Reference 

• Help:   

o Reference Property 

o Table 

o Heatmap 

o Data Diagram 

Table Control 

Display Icons from AssetWorX Configuration 

(Reference ID: 72714) 

The table control can now display a column of icons. It can interpret a string column as 

an AssetWorX icon path and display that icon. 

The source for these icons is the AssetWorX icon repository, configured in Workbench 

under Assets > Product configuration > Images. The expected format of the string is: 

ac:.Icon Definitions/name (example: ac:.Icon Definitions/Enterprise). Note that 

expressions can be used to build the string name if the database or asset provides only 

part of the required string (example expression: x="ac:.Icon Definitions/" + 

{{@@value}}). 

To change a string column into an icon, go to the Columns page, select the column in 

question, and set the Content Type to Icon. 

The fault viewer control also supports this feature. See Asset Icons. 

For Further Reference 

• Help:   

o Display Icons from AssetWorX Configuration 

o Table 

o Images Node 

Additional Enhancements 

General 

Ref ID Description 

75888 

75836 
Made some minor styling enhancements to control configuration dialogs. 

https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/GWX/Reference_Property.htm
https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/GWX/Table.htm
https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/GWX/Heatmap.htm
https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/GWX/Data_Diagram.htm
https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/GWX/Display_Icons_from_AssetWorX_Configuration.htm
https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/GWX/Table.htm
https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/AssetWorX/Images_Node.htm
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Data Diagram 

Ref ID Description 

60789 
The color scale field on the Color Axis page of the heatmap and data diagram controls now includes a color picker 

button and a visual representation of the currently chosen color scale. 

Table Control 

Ref ID Description 

58312 

Added a new property called Maximum String Size. It can be found on the General page in the Data section. This 

property, which defaults to 1000, limits the number of characters displayed for string values. This improves the 

performance when data sources contained extremely long strings. 

71481 The sub-header can now be styled like the main header. There is a new configuration group for the sub-header style. 

72215 The configure mode "preview" of real number columns now displays them with decimal places. 

72460 

The scrollbar performance has been improved when using incremental loading to better reflect the size of the full 

data source on the server and respond more intuitively when more rows are loaded from the server. 

 

When incremental loading is disabled, the contents of old pages are no longer discarded. This means when a user 

moves from page one to page two then back to page one, page one's data will load immediately without having to 

retrieve the rows from the server again. 

 

Scrollbar performance in general has been improved. 

72747 The scroll position is now maintained after the data source is refreshed. 

72789 
When using an FDDWorX table (data source of AnalytiX > FDDWorX > .Query) and creating a filter, only the "equals" 

operator was allowed for some columns. Now all filter operations are available on all FDDWorX table columns. 

72838 
Added "Margin" as a new property of columns. Margin determines the minimum space allowed between the cell 

content and the cell border. 

74806 

Tag names contained in data source values can now be resolved and the runtime values displayed. To configure this, 

go to the Columns page, select the column that contains a tag name, and set the Content Type to Data Source. 

 

The resolved value of a data source can also be used in an expression. Use @@resolvedvalue to refer to the resolved 

value of a data source. 

75131 
When adding a filter, the tag browser now displays the Simulation tab, allowing users to choose localsim values for 

the filter's value field. Prior to this fix, localsim values worked but the user had to type them in manually. 

75496 

Added a "Row Click" event to the table and fault viewer controls. This new event is different from the preexisting 

"Row Selected" event because "Row Selected" only occurs when the row is first selected. The row must first be 

deselected before the "Row Selected" event will be triggered again for that row. The new "Row Click" event will be 

executed any time the row is clicked or touched, even if it is already selected. 

75789 

Previously, the “Generate fields from list of data columns” button on the Fields page would completely drop the 

existing set of fields and reload them from scratch. Now it only adds new fields and removes missing fields. This 

preserves existing configuration (such as aggregates, grouping, and sorting) for fields that still exist after the schema 

update. 

GraphWorX64  

Ref ID Description 

75027 

When importing IFC models, equipment class properties are now created for the imported assets, where applicable. 

 

Also, equipment classes created as part of the import are now created in a folder named for the root folder of the 

imported equipment. This ensures that the user can import two projects with similar objects but different sets of 

properties without the classes overwriting each other. 
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RecipeWorX 

Recipe Navigator 

Ref ID Description 

75015 

To use the value of a global alias as a root node, users can now enter just the <#alias#> syntax in the Root Node 

Path properly. Previously, expression syntax like this was required: {{"<#alias#>"}}. The previous expression syntax is 

still supported. 

ScheduleWorX64 

Major Enhancements 

ScheduleWorX64 Viewer 

Enhanced Commanding Support 

(Reference ID: 71915) 

Commanding support for the ScheduleWorX64 Viewer has been enhanced. Users can 

now configure their own pick actions to perform common scheduling actions for the 

viewer. 

There is a new command called Schedule Event. The Schedule Event command can be 

used to create, edit, and delete events. Use the Action parameter to determine which of 

the three subcommands is executed. 

The ScheduleWorX64 Viewer is now a valid target for the preexisting Refresh and Apply 

Discard commands.  

For Further Reference 

• Help:   

o Schedule Event Command (in Equipment in Assets) 

o Schedule Event Command (in Equipment Classes in Assets) 

o Schedule Event Command (in GraphWorX64) 

Additional Enhancements 

Schedule Control 

Ref ID Description 

62541 

The BACnet Schedule Viewer and Workbench provider now attempt to save calendar entries by list modification 

instead of saving the entire property value. If the list modification fails (for instance, if it is not supported by the 

device), it will fall back to saving the entire property value. 

https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/AssetWorX/Commands_Tab_for_Equipment.htm%23Schedule_Event_Command
https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/AssetWorX/Commands_Tab_for_Equipment_Classes.htm%23Schedule_Event_Command
https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/GWX/Commanding.htm%23Schedule_Event
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TrendWorX64  

Major Enhancements 

TrendWorX64 Viewer 

Customizable Export Statistic Command 

(Reference ID: 72841, 74552) 

The report generated by the Export Statistic command with a TrendWorX64 Viewer 

target has been enhanced to be more customizable. 

Previously, running the Export Statistic command with a target of a TrendWorX64 

Viewer would perform the same action as selecting the Export Statistics button in the 

trend viewer toolbar, which was to display a report that then could be saved to CSV or 

other formats.  

Now, the action taken by the command depends on the TrendWorX64 Viewer 

configuration. The command itself has no new parameters, but in the target 

TrendWorX64 Viewer the user can select the chart, go to the Data tab, and select the 

Configure button next to Statistics Export. Similar to the preexisting data export 

configuration, the statistics export configuration presents various configurable settings 

for the statistics report, including which columns to include in the report and whether to 

export visible pens. 

By default, the Export Statistic command now immediately saves the report to a CSV file, 

but the user can return to the legacy behavior of opening the report page by selecting 

Use legacy export in the statistics export settings. 

This functionality of the Export Statistic command is currently only supported in desktop 

(WPF) and Universal Windows Platform (UWP). Equivalent functionality for the HTML5 

trend viewer is planned for a future version. 

For Further Reference 

• Help:   

o Export Statistic Command (in GraphWorX64) 

o Export Statistic Command (Equipment in Assets) 

o Export Statistic Command (Equipment Classes in Assets) 

https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/GWX/Commanding.htm%23Export_Statistic_Command
https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/AssetWorX/Commands_Tab_for_Equipment.htm%23Export_Statistic_Command
https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/AssetWorX/Commands_Tab_for_Equipment_Classes.htm%23Export_Statistic_Command
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Additional Enhancements 

TrendWorX64 Logger 

Ref ID Description 

72742 

Sometimes when logging expressions the expression will be evaluated before the first update of its source tags is 

received. This results in the first sample logged for that expression to be bad quality. To avoid this issue, users can 

now set this IcoSetup64.ini entry. This entry will force TrendWorX64 Logger to wait until it has the first good quality 

evaluation of an expression before it begins logging samples for it. 

 

[TWXLOG64\Data] 

IgnoreFirstBadExpression=1 

TrendWorX64 Viewer 

Ref ID Description 

74134 

TrendWorX64 Viewer now better supports the desktop/web/mobile configuration mode when choosing plot types. 

The previous "Show plots available on all platform" box has been removed, and the available plot types are 

automatically filtered based on the configuration mode. The current plot type is highlighted at the top of the dialog 

so that the user can see the current plot type even if it is not supported by the current configuration mode. 

77861 

The TrendWorX64 Viewer can now visualize unsorted datasets. It will sort samples chronologically in runtime. 

Previously it could only visualize datasets that were already sorted chronologically. This means it should be easier to 

display BACnet trendlog objects, in particular. 
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Hyper Historian 

Hyper Historian Performance Calculations 

Ref ID Description 

73329 

Added four new methods to the FunctionLibrary class (used when creating custom calculation function libraries): 

 

* AddValue(IDataVariableNode variableNode, bool replaceExisting, LoggerDataValue value) 

* DeleteValue(IDataVariableNode variableNode, DateTime timestamp) 

* AddRecalculatedValue(IDataVariableNode variableNode, DateTime previousValueTimestamp, LoggerDataValue 

value) 

* DeleteValues(IDataVariableNode variableNode, DateTime start, DateTime end) 

 

These methods can be used to add, update, or delete samples from non-collected tags. 

Hyper Historian Workbench Provider 

Ref ID Description 

69220 

74684 

For Hyper Historian tags, the "In Group" and "Merge Group" fields now display both the data logger and the 

logging/merge group to help distinguish when there are groups with the same name under different loggers. 

72752 

74223 
Minor changes to the behavior of the Data Exporter datasets configuration dialogs to make them more intuitive. 

74504 For Data Exporter datasets, the default PointName column's length has been extended to 255 characters. 

74633 
Azure authentication strings are now encrypted in the Data Exporter configuration database and sensitive parts of the 

strings are now masked when being displayed in Workbench. 
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IoTWorX & Internet of Things 

IoT Analyzer 

Major Enhancements 

IoT Analyzer Fault Incidents Available as Alarms 

(Reference ID: 73240) 

IoT Analyzer fault incidents are now available as alarms.  

To see to fault incident alarms in the IoT Visualizer, add an alarm widget and configure it 

to subscribe to AnalytiX > IoT Analyzer > your analyzer group name. The resulting 

alarm point should look like analyze:GroupName. 

For Further Reference 

• Help:   

o Analyzer 

o Visualizer 

IoT Data Sources 

Major Enhancements 

BACnet Connectivity in IoTWorX Edge Devices 

(Reference ID: 67844) 

The BACnet Point Manager is now available to version 10.96.1 IoTWorX edge devices. 

This implementation of BACnet uses .NET Standard, allowing us to deploy to supported 

Linux devices. (The lack of BACnet connectivity was listed as a known issue for the 10.96 

release.) 

The new IoTWorX BACnet provider includes some features that are not yet available to 

the desktop BACnet provider. These features include: 

• The BACnet cache is now stored in the configuration database instead of a CSV 

file. 

• Support for channels. 

• Library of supported properties. 

• New and improved network discovery dialog. 

• Compliance with ANSI/ASHRAE Standard 135-2016 (revision 19). 

https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Com/Tools/IoTWorX/Analyzer.htm
https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Com/Tools/IoTWorX/Visualizer_Tab.htm
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We plan to include these features in the desktop BACnet provider in a later version. 

When creating a new IoT project, make sure to select the BACnet application to get 

BACnet connectivity on your devices. To add BACnet connectivity to an existing project: 

1) Go to Project > Configure Database. 

2) Select the database used by your IoT project and select Next. 

3) If it is not already installed, check the Install/Overwrite box for BACnet. 

4) Select Install if you made changes, otherwise select Cancel. 

5) When the database has been installed successfully, expand your IoT project > 

Device Templates. 

6) Right-click your template and select Configure Application(s) Settings 

7) Enable the BACnet application. 

8) Make sure Update the applications in all groups associated with this 

template is enabled. 

9) Select Apply. 

10) Repeat for any other templates where you would like to add BACnet connectivity. 

Once BACnet has been added to your project, configure BACnet under Device 

Templates > template > Data Connectivity > BACnet.  

To add the BACnet module to a specific device, right-click the device and select 

Configure Modules, select Click to configure modules, check the Deploy box for the 

BACnet Point Manager, then select Deploy.  

Once BACnet has been configured in your template and the modules have been 

deployed, right-click on your device, select Deploy Device(s) Configuration to deploy 

the configuration to the device.  

For Further Reference 

• Help:  

o BACnet Configuration in IoTWorX 

IoT General 

Ref ID Description 

64954 

72737 

Sending IoT Analyzer fault incidents to FDDWorX via IoT Hub and MQTT broker is now supported. Previously fault 

incidents could only be sent by Platform Services (FrameWorX) communication. This was documented as a known 

limitation for 10.96. 

74042 

74043 

Users can now change the ports used by the Diagnostics and Configuration pages and IoT Visualizer. Previously these 

ports were hard-coded. Now they can be modified in /usr/share/ICONICS/IoT/uiOptions.json. 

https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Com/Tools/IoTWorX/BACnet_Configuration_in_IoTWorX.htm
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Internet of Things Workbench Provider 

Ref ID Description 

74444 
When configuring publish lists, the user can no longer choose loggers that are used by subscribers. This 

configuration was never valid and would cause elements in the publish list to fail completely. 

74757 
Imports into Internet of Things branches of the Workbench tree now include an "Ignore GUID" option. When this 

option is enabled the import will ignore the GUIDs in the import and use the name to identify items. 

77806 
Users can now restart a gateway (edge) device from Workbench. In the IoT project, right-click the device and choose 

"Restart Gateway". 
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KPIWorX 

Major Enhancements 

Widgets 

Pivot Functionality in Table and Categorical Chart 

(Reference IDs: 55383, 55391, 74046) 

Table and categorical chart widgets now include a "pivot" functionality. This feature is 

only available for AnalytiX-BI data sources. Pivoting a dataset involves taking unique 

values from one column and turning them into multiple columns or series in the output. 

To pivot a table widget, select one dataset column with an aggregate for the Columns 

field and one dataset column for the new Pivot field. If you would like to display more 

than one row, select a third column for the Group By (Rows) field. The unique values 

provided by the Pivot column will be used for the table's column headers. If Group By is 

used, the unique values provided by the Group By column will be used as an additional 

first table column, identifying each row. The aggregated value for the Columns column 

will be used in the cells. 

When pivoting the Columns field must contain only one column, and it must be 

aggregated. 

To see an example of pivoting using the example Northwind AnalytiX-BI data model, 

follow these steps: 

1) Add a table widget to your dashboard. 

2) In the data browser, browse to AnalytiX > BI Server > Data Models > 

Northwind. 

3) Select the table widget and open the Widget Settings panel. 

4) Expand OrderDetails > Quantity and drag Avg into the Columns field. 

5) Expand Customers and drag Country into the Group By (Rows) field. 

6) Expand Categories and drag CategoryName into the Pivot field. 

7) You should now have a table showing the average quantity of each product type 

ordered by customers in different countries. 
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To pivot a categorical chart widget, choose a dataset column for Category (X-axis) as 

normal. Choose an aggregated dataset column for Value (Y-axis). Then choose a third 

dataset column for Pivot. One series will be added to the chart for every unique value of 

the pivot column. 

 

For Further Reference 

• Help: Pivot Functionality in Table and Categorical Chart 

Additional Enhancements 

Ref ID Description 

44909 
Enhanced the widget property grid and added a tooltip with the property name for cases where a property name is 

too long to be completely visible. 

61105 There is now a "Refresh" context menu item in the data browser. 

https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/KPIWorX/Pivot_Functionality_in_Table_and_Categorical_Chart_Widgets.htm
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Ref ID Description 

65413 
The filter dialog in the KPIWorX header now keeps information about the current drilldown level. It is also now 

possible to go back and forward in the drilldown history. 

65416 Added an OpenXML export ("Data XML") when choosing the "Share" option on a widget. 

70056 
A GenEvent is now logged when KPIWorX dashboards are accessed. The log includes the security username, 

dashboard name, and whether access was allowed or denied. 

71061 
Sorting one control no longer forces the same sort on other controls. Also, the table control now includes Sort order 

and Sort by properties, allowing the users to pick a default sort. 

74242 
Asset and time series can now have their hierarchical drill-down disabled. After mapping adding a column to a 

widget, select the column's dropdown in the widget settings panel and choose Flat instead of Hierarchy. 

74645 
For DateTime columns, users can now choose a specific date part to display in their widgets such as year, month, day, 

etc. Expand the DateTime column and drag the appropriate level into the widget or Widget Settings panel. 

75916 

In the table widget's settings, added a new alignment property for columns. In the Widget Settings panel, scroll to 

the Columns section, choose a column, then set the alignment. This will determine the alignment of the cell values for 

that column. 

75917 
Data Diagrams can now reverse the color axis. In the Widget Settings panel, go to the Appearance section and toggle 

Reverse. 
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MobileHMI & HTML5 WebHMI 

HTML5, iOS, Android Platform 

Major Enhancements 

Common 

Feature Parity Improvements 

HTML5 browsers and the MobileHMI apps for iOS and Android can now use the 

following features and functionality that were previously only available in the desktop 

GraphWorX64 app (WPF) or the Universal Windows Platform (WPF) MobileHMI app. 

General 
Ref ID Description 

70252 

60350 

70388 

Reduced minor graphical differences between equivalent WPF and HTML5 displays. 

AlarmWorX64 Viewer 
Ref ID Description 

70274 Custom Beep File property of conditions 

70584 The X icon in the list and flip view search bars 

70585 In list view, selecting an alarm to toggle the details pane open and closed 

71119 Drill-down support in charts 

71213 ShowFieldValue advanced property for donut and pie charts to toggle between showing the field value or percentage 

71467 
The details panel (advanced setting: ShowDetails). Note, there are some limitations due to the platform. Notably, 

marquee animation is not supported. 

72781 Sorting on hidden fields 

72798 Transparent color in the MouseOverBackground advanced property 

74124 

74126 
In list view, the Wrap Text and Trim Text options for columns 

74713 ShowPopup property for disabling the context menu 

76366 The "Show the original value…" option on the Text Translator tab 

Commanding 
Ref ID Description 

70919 The @@data.count context variable for events in controls 

75104 Using wildcards in the PenName field of the Delete Pen command 

EarthWorX 
Ref ID Description 

72731 

72736 

Localsim:property tags for ActualLatitude, ActualLongitude, ActualZoomLevel, ActualLatitudeStorage, and 

ActualLongitudeStorage* 

GraphWorX64  
Ref ID Description 

63118 
Images in the Background property of the canvas (note, currently only works for root displays, not embedded 

viewers) 

65624 The padding property for the scale control. 

71194 The localsim:property:Document.MinimumZoom and localsim:property:Document.MaximumZoom tags 

71199 The "View - Toggle Box Zoom" subcommand of the "Local Runtime Menu Command" local command 

74630 DataEntryLostFocusWritesValue property of process points 



MobileHMI & HTML5 WebHMI - HTML5, iOS, Android Platform 

41 

Ref ID Description 

74715 
The localsim:property tags for the tooltip options, such as 

localsim:property:Document.ToolTipOptions.ShowToolTips* 

75112 UseDisabledColors property 

GridWorX Viewer  
Ref ID Description 

63863 Global colors in grid cells 

70372 
The "Show the filter in runtime" option on a grid under the Behavior tab > Configure default client-side filter(s) > add 

or edit a filter. 

74173 

74174 
Enhanced cursor format 

74176 
Updating the rendering of a GridWorX Viewer chart using localsim:property: ChartName.Series [Index].PropertyName 

tags* 

74318 The y-axis Interval and Offset fields configured per series on the Series tab 

74332 
CursorBackground, CursorForeground, CursorFontSize, and CursorFontFamily properties (note, CursorBorderBrush 

and CursorBorderThickness are not supported because in HTML5 the tooltips have no border) 

74713 ShowPopup property for disabling the context menu 

75229 Chart series commands that were a new WPF feature in version 10.96. 

 

* Note that localsim:property tags are not universally supported in HTML5 due to the 

difference in structure between desktop (WPF) and HTML5 displays. Where possible, 

commanding should be used instead of modifying localsim:property tags. 

Specifying Language in URL 

(Reference ID: 74338) 

HTML5 WebHMI displays can now specify the language to use for Language Aliasing in 

the URL of the display. This is done by specifying the "lang" parameter in the URL and 

passing in the language code. Set "lang" equal to the culture name or "language tag" of 

the language to be used. 

This feature allows multi-language sites to give separate URLs to their users to load the 

site in their native language without having to create separate pages on the server side 

to load the language. While it is possible to specify a default language for a security 

user, specifying the language in the URL allows pages to be translated before anyone 

logs in or on pages that do not require a login. 

Example URLs: 

• http://servername/AnyGlass/PubDisplay/Display1.gdfx?lang=fr 

• http://servername/AnyGlass/PubDisplay/Display2.gdfx?lang=en-GB 

When specified in this fashion, the display acts as if the Set Language command was 

processed upon display load. 

For Further Reference 

• Help: Specifying Language in URL 

https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Com/Intro/Specifying_Language_in_URL.htm
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iOS & Android Apps 

Push Notification Support 

(Reference ID: 66140) 

Version 10.96 introduced Azure-based push notifications for the Universal Windows 

Platform (UWP) app (reference ID 68034). Version 10.96.1 extends that functionality to 

the iOS and Android apps. 

These new notifications leverage Azure functionality to deliver notices to specific devices 

or specific users. Also, the Send Notification command can be used to generate any 

custom notification message. It does not have to be linked to alarms or events. 

Currently UWP, iOS, or Android apps must be customized per organization. Contact 

your ICONICS sales representative for information on how to get your own customized 

version of the MobileHMI app to support push notifications. 

For Further Reference 

• Help: Azure-Based Push Notifications  

Additional Enhancements 

General 

Ref ID Description 

66829 Refined the error level of some TraceWorX messages logged by the HTML5 engine. 

66995 HTML5 displays now support dynamic URLs such as those used with reverse proxy services. 

Camera Control 

Ref ID Description 

61391 

Previously, when users of the MobileHMI iOS or Android app connected to a secured server and encountered an 

issue with the certificate they would be unable to connect to that server. Now, the problem with the certificate is 

displayed to the user and they are given the option to ignore the certificate problems and continue to the site. 

GraphWorX64 

Ref ID Description 

70057 
A GenEvent is now logged when HTML5 displays are accessed. The log includes the security username, file URL, and 

whether file access was allowed or denied. 

GridWorX Viewer 

Ref ID Description 

72061 
Pie and donut chart labels are anchored closer to the slices to be more consistent with the chart rendering in desktop 

(WPF) and improve readability. 

74168 

Language aliases can now be resolved in HTML5 GridWorX Viewer charts. Note, language aliasing in charts is 

currently not supported for Universal Windows Platform (UWP) and desktop (WPF) platforms. We plan to add it in a 

future version. 

https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/MobileHMI/Azure-based_Push_Notifications.htm
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Ref ID Description 

74224 

GridWorX charts with very long vertical legends now display the legend in a scrollable list instead of wrapping around 

to a second column. This is more consistent with the desktop (WPF) format and provides more space for the actual 

chart. 

Schedule Control 

Ref ID Description 

73065 

Improved the performance of the load time for the schedule viewer. 

 

Further performance improvement can be achieved by editing the viewer, going to the Advanced tab, and setting 

HidePastYears to True. This option is disabled by default for backwards compatibility but enabling it can greatly 

enhance performance. 

74039 
The HTML5 ScheduleWorX Viewer now shows errors in the bottom of the control instead of as popup message 

boxes. 

TrendWorX64 Viewer 

Ref ID Description 

52266 
When right-clicking on a pen in the TrendWorX64 Viewer, the context menu now includes a "Delete" option, allowing 

the user to easily delete the selected pen. 
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Platform Services 

Commanding 

Ref ID Description 

25624 

The Acknowledge command has a new property, ShowDialog. When set to true, the Acknowledge command will 

display the same acknowledgment dialog that users see when acknowledging alarms via the alarm viewer. The other 

fields will be used as initial values in the dialog, in this case. 

 

This use of the Acknowledge command is currently not supported for Universal Windows Platform (UWP). 

71057 
When configuring a Set Global Aliases command (commands on events or commands in context menus), there is 

now a new button for the GlobalAliases field that opens the standard tag browser, including the expression editor. 

76640 

75862 

Many command fields supported dynamic tags, but there was no way to browse for them in the command editor 

(used in batch commands and in many controls). An additional tag browser button has been added for these fields. 

FrameWorX Server 

Major Enhancements 

Read Only Option 

(Reference ID: 39706) 

For systems designed for monitoring only, FrameWorX now provides an option to 

prevent writing to any OPC servers or point managers. 

From the start menu or Workbench, open Platform Services Configuration, go to the 

Advanced tab, and select Read only. 

When enabled all points coming through this FrameWorX server will be treated as read 

only. Users will be unable to write to real-time points, historical points, or datasets. This 

is an alternative to ensuring that all users and groups in security cannot write to points, 

and functions even when security is disabled. This read only option cannot be 

overridden by security permissions. 

This option is designed to work like the Read Only option in the GENESIS32 or BizViz 

GenBroker Configurator under Advanced > Server > Security. 

For Further Reference 

• Help:   

o Read Only Option 

o Platform Services Configuration 

Additional Enhancements 

Ref ID Description 

49937 Added two extended point syntax (EPS) functions: 

https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Com/Tools/Data/Read_Only_Option.htm
https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/Platform_Services_Configuration.htm
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Ref ID Description 

 

* statuscode(pointName) - Returns the numeric status code of the point 

* statustext(pointName) - Returns the point status as localized text (such as "Bad - Not Implemented") 

 

Note, these are not expression editor functions. When used in expressions they need to go inside of the curly 

brackets, such as: x={{statustext(svrsim:sine int32 bad -100 100)}} 

 

These functions can either be typed in manually or chosen from the EPS dropdown at the bottom of the data 

browser. 

Expressions 

Major Enhancements 

Switch Statement 

(Reference IDs: 70817, 72458, 72982) 

The expression editor now supports switch statements. These statements can replace 

long series of IF-THEN statements. They are used to covert single expression values to 

other values, most often integer values to strings. The syntax is very similar to that used 

by Transact-SQL. 

The syntax is as follows: 

CASE input_expression    

     WHEN when_constant_expression THEN result_expression [ 1...n ]    

     [ ELSE else_result_expression ]    

END   

  

Where: 

• input_expression is any standard expression, such as an external variable (like {{my 

variable}}) or combination of functions and variable(s). 

• when_constant_expression can be any constant or constant expression, such as: 1 

+ 2, “my text”, etc. All WHEN expressions values must have the same data type – 

either numbers or strings – and must be unique within CASE statement. 

• result_expression and else_result_expression are any standard expression text. 

The statement will try to match the input expression to one of the WHEN values. If a 

match is found, the statement will return the value in the following THEN expression. 

Multiple WHEN statements can be called in a row to have them all return the same 

THEN value. 

If no WHEN value can be matched, the value in the ELSE expression will be returned. The 

ELSE section is optional. When it is omitted, an empty value will be used. 
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Example expressions using the switch statement: 

CASE {{my tag}} 

  WHEN 1  

  WHEN 2 THEN "A" 

  WHEN 3 THEN "B" 

  WHEN 8 

  WHEN 9  

  WHEN 10 THEN "C" 

  ELSE "D" 

END 

 

 

CASE {{my tag}} 

  WHEN "A" 

  WHEN "B" THEN 0 

  WHEN "C"  

  WHEN "D" THEN 1 

  ELSE 2 

END 

 

 

CASE {{my tag}} - 10 

  WHEN 1  

  WHEN 2 THEN {{my second tag}} 

  WHEN 3 THEN {{my second tag}} + {{my tag}} 

  WHEN 8 

  WHEN 9  

  WHEN 10 THEN {{my third tag}} 

END 

 

For Further Reference 

• Help:   

o Switch Statement 

o Expression Editor 

 

Code Blocks and Looping 

(Reference ID: 73070, 73071) 

As new functionality has been added to the expression engine over the years, 

expressions have grown more and more complex, difficult to read, and difficult to 

maintain. To help simplify complex expressions, users can now optionally use code 

blocks, which provide looping functionality and fast access to internal variables. 

DECLARE 

Optional internal variable declaration section 

(example: @myvariable; @mysecondVariable = 10;) 

BEGIN 

 Code section with code lines... 

END 

 

https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Com/Tools/Data/Switch_Statement.htm
https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Com/Tools/Data/Expression_Editor.htm
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Each code block returns a single value. Code blocks can be used by themselves or in line 

with standard expression editor functions. 

Inside the code section of a code block, users can utilize new commands, such as SET, 

FOR, FOREACH and EXIT. See the reference links below for more details and examples 

on how to use the new code blocks. 

For Further Reference 

• Help:   

o Code Blocks and Looping 

o Expression Editor 

Array Manipulation Functions 

(Reference IDs: 73098, 73099) 

New functions were added to aid in array manipulation: 

• createarray (length) – Creates an empty array with the specified length. 

• createtypedarray (datatype, length) – Create an array with the specified length 

where all elements are of the specified datatype. 

• setlen (array, length) – Modify the number of elements stored in the array. 

• setat (array, index, value) – Set the value at the specific index (zero-based). 

For Further Reference 

• Help: Expression Editor 

Additional Enhancements 

Ref ID Description 

74230 
Added new functions: bhour, bminute, and bsecond. These functions act like the preexisting b-time functions (such 

as bmonth and byear) to round a datetime value to the beginning of the hour, minute, or second. 

MonitorWorX Viewer 

Ref ID Description 

73959 
Users can now launch the login dialog from the MonitorWorX Viewer tool. Select the security info in the bottom right 

corner. 

OData Connector 

Ref ID Description 

72833 The OData Connector Point Manager can now only run out of process. 

https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Com/Tools/Data/Code_Blocks_and_Looping.htm
https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Com/Tools/Data/Expression_Editor.htm
https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Com/Tools/Data/Expression_Editor.htm
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Redundancy Support 

Major Enhancements 

Enabling Point (Forced Redundancy Failover Support) for FrameWorX and Point 
Managers 

(Reference IDs: 47214, 50505, 64910) 

Users can now force a redundancy failover for FrameWorX or individual point managers. 

Point managers and FrameWorX as a whole can have a particular point associated with 

them, called an enabling point, and when the enabling point evaluates to zero or bad 

quality that FrameWorX or point manager instance will go offline. This feature can be 

used to identify point managers or FrameWorX instances that are in an undesirable state 

and prevent clients from using them. 

In a standard redundancy scenario, a client will only connect to the secondary point 

manager if the primary point manager is not responding. There could be other 

problems with the primary point manager, however, such as if it has lost connection to 

its source data. The primary point manager would still be detected as online in this case, 

even though all of its data points would be bad quality. Clients may continue talking to 

it, even if the secondary point manager has good quality points. With this enabling 

point feature, the presence of a particular bad quality point could be used to force this 

point manager to report itself as offline, causing clients to failover to the second 

functional point manager. 

To configure an enabling point for FrameWorX, open Platform Services Configuration 

from Workbench or the start menu, then go to the Advanced tab. Enter a point name 

into the Server Enabling Point field. 

To configure an enabling point for an individual point manager, open Platform 

Services Configuration from Workbench or the start menu, then go to the Point 

Managers tab. Find your desired point manager in the list, then scroll to the right to 

find the Enabling Point column. Enter a or point name into this column. Note that this 

feature is only supported for point managers running out-of-process.  

Enabling points must be a single point, not an expression, however users can configure 

an expression tag in the Unified Data Manager (Platform Services > Unified Data 

Manager > Expressions) and use that exp: tag as an enabling point, if desired. 
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Note that FrameWorX and point managers disabled by their enabling point will still 

function, they will simply close any existing client connections and reject any further 

communication attempts from clients until the enabling point allows them to come 

online again. 

These features were designed for a redundancy scenario, but they can also be used in a 

non-redundant scenario to temporarily prevent clients from connecting to a particular 

point manager or FrameWorX.  

Users are encouraged to utilize this feature with care, as using an unreliable enabling 

point can cause a FrameWorX server or point manager to appear to go offline for no 

good reason. If a FrameWorX server or point manager's communication was disabled 

due to its enabling point, a message will be logged in TraceWorX at the error level. 

This feature is similar to the preexisting "Controlled Redundant Servers" feature for OPC 

Classic servers, configured in Workbench under Platform Services > FrameWorX > 

Server Settings > GenBroker64 Settings. Note that the "Controlled Redundant 

Servers" feature is evaluated on the client side, which is different from the enabling 

points for FrameWorX and point managers. 

For Further Reference 

• Help: Enabling Point for FrameWorX and Point Managers 

Security 

Major Enhancements 

Secure Alarms by Asset Name 

(Reference ID: 71301) 

When subscribing to assets for alarms and events, the viewing and acknowledgement of 

those alarms can now be secured by the asset path. This provides a more intuitive way 

to secure alarms for users who rely heavily on assets. 

To support this feature, there is a new setting configured in Workbench under Assets > 

Product configuration > Alarms & Events settings > General settings and 

subscriptions called Modify SourceName to start with Equipment or Property point 

name. This setting is enabled by default. When it is enabled, the SourceName field of 

alarms subscribed via AssetWorX is modified to include the equipment or property 

name.  

An example SourceName would be: 

https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/FrameWorX/Enabling_Point_for_FrameWorX_and_Point_Managers.htm
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ac:Alarms/Plant Area B/Sub Area A/:0:@ICONICS.AlarmSvr.1\Valve1.Limit.Condition 

Including the asset name like this allows the Alarms tab of users or groups in security to 

properly match alarms with the asset tree. It would be possible to deny users the ability 

to acknowledge alarms under "Sub Area A" by denying them ac:Alarms/Plant Area 

B/Sub Area A/* on the Alarms tab. 

For Further Reference 

• Help:  

o Secure Alarms by Asset Name 

o General Settings and Subscriptions 

o Security Privileges for Users and Groups (Alarms Tab) 

Additional Enhancements 

Ref ID Description 

72874 

72943 

In application actions under Workbench > Schedules, the Monitor Mode, Override, and Print application actions have 

been removed. The Monitor Mode and Print application actions were obsolete. To prevent users from overriding 

schedules via Workbench, remove the entire Workbench > Schedules application action. 

76882 
The "Show currently logged in user in login dialog" setting now also disables the "Advanced" button in the login 

dialog, which shows a list of currently logged-in users. 

Security Workbench Provider 

Ref ID Description 

72478 
It is now possible to copy and paste rights from one group to another using the context menu. Previously it was only 

possible to copy and paste rights between users. 

73044 Multiple small updates to configuration dialogs to enhance usability. 

Server Internal Simulator 

Major Enhancements 

Simulator Registers 

(Reference ID: 75533) 

The Server Internal Simulator (browsable under Platform Services) now includes 

registers. These registers work similarly to the preexisting svrsim:out points, except they 

can use custom names and are not limited to one point per data type. Because they are 

evaluated by the server, these simulation registers allow the user to share values 

between clients and are usable on IoTWorX edge devices. 

Registers are not configured in advance and are not browsable. Simply use a tag with 

this format wherever you would use an OPC UA or other tag name: 

svrsim:reg datatype identifier 

https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/AssetWorX/Secure_Alarms_by_Asset_Name.htm
https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/AssetWorX/General_Settings_and_Subscriptions.htm
https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/Security/SEC10001005_Security_Privileges.htm%23Alarms
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Datatype is the desired data type supported by the simulator and identifier is a custom 

string used to identify this particular register tag. Example: svrsim:reg int 

myRegisterName 

Note, only 64 unique registers are supported. If a project attempts to use more than 64 

unique identifiers the registers beyond the 64th will return a bad status code. Registers 

are counted as points in terms of licensing. 

For Further Reference 

• Help: Simulator Registers 

Triggers 

Ref ID Description 

65390 

Data triggers and time triggers have a new DA property called ConditionActive. If the trigger is an event trigger, this 

property will be an empty string. If the trigger is a condition trigger, the property will be true when the condition is 

active and false when the condition is not active. 

https://docs.iconics.com/V10.96.1/GENESIS64/Help/ICONICS_Product_Help.htm#Com/Tools/Data/Simulator_Registers.htm
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Workbench 

Ref ID Description 

61828 

Enhanced the way certificates are managed in Workbench.  

 

When browsing certificates, you now get a list of all certificates that are visible to FrameWorX Server. Previously, for 

standard projects only certificates in the certificate store were available, and for IoT projects browsing was not 

possible at all. 

 

Certificates can now be browsed respective to a particular edge device. When browsing for certificates in an IoT 

project (such as when configuring security settings for an MQTT broker), the user will be prompted to pick a device 

and then choose from certificates present on that device. 

 

The Project Files provider can now be used to create, import, and restore certificates to the certificate folder, 

C:\ProgramData\ICONICS\pki, where they should be automatically recognized and visible to FrameWorX. 

70553 
In Platform Services Configuration on the Point Managers tab, the main table can now be sorted by many of the 

columns, including the point manager name. Click on the header to sort by that header or reverse the sorting order. 

71853 
To help prevent accidental data loss, a warning was added when the user chooses the "Purge database" option on 

import. 

72961 Sorting and filtering are now allowed in the Configure Database dialog's list of configurations. 

72965 It is now possible to filter on the Description column in the Project Details panel. 

72966 It is now possible to reorder columns in the Project Details panel. 

72970 
It is now possible to restrict access to the Usability section of the Workbench Tools ribbon. In security, the 

Workbench > Project Management application action controls access to that section. 

74434 

After adding an application to a project, if the database does not already include configuration tables for that 

application, the tables can now be quickly added from the Project Explorer. Right-click on the application and choose 

"Create configuration" or select the application and choose "Create configuration" from the Home menu. 

Project Files 

Ref ID Description 

74317 Environment variables such as %USERPROFILE% can now be used in custom destination folders of archives. 
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